EUT:SCANNER

FCC ID:ITEUECVS12P

ULTIMA ELECTRONICS CORP.

USER’S MANUAL

: IF‘.YT-TTRT'T' rl



Table of Contents

Getting Started with TWAIN Source

Opening the TWAIN Source WIndow ... 3
MR PAZE cooiiiiiiiiinitritennersestsiesassnesnsbtsssssesnsanesssanssosssasasssbasssssasasnsans 4
Settings in Main PAge ....ocovionimi e 5
DESHITIALION  ..eeevvre o ceeeieeeieeeae e s e eree s e meean e e ebe s 5

SCAN MOAE .o e e 6

2E1 1= STUUUTR OO U O PP POTOESTUPPPS PP EPPRIOR 6
RESOIULION et e et eee e eae e e e e etr e sttt a s 7
Brightiess . ccee oo 7

CONILASE <o eeeeeeeeeee e e e eaveeesaneeeasessaeeessns b e s esber e nna s e e e s 7

Control Buttons in Main Page ... 8
AdVANCE PAZE ..ccreiricererieintisieninnnn bttt s s e 9
Image Enhancement Tools — Image BoX..oooonninn. 9
410 ) s TRUUUU TR U U U PP GO PPPR S PPPRPP 10

Y (TS ce ) VTR R R UU USROS PI O PPPP PP SPPPSSPTPPIP 10

1§ N2 ATTRUTOT VT TR U PSSP PP S SUPPRPSUPPPPERPPTPPPPITS 10

DT n==) t UTUUTR DR TR OO PP P TP PPSPPPPPPPPRIPPRIRE: 11

GAITIITIA «oe e eeeeeeeee et e e e i ee et e eaeeb oo et s e s anaraat e s e e e s s aabae e e e e 11

S Y ettt s 12

Tone AdJUSLMENT ....c.ovrmiriiiiiie e s 13

Auto Color Control. .. 14

COlOT COITECLION . .eiiiiireeeeeeerreeesirameeaaresess s s abba e 14

{mage Enhancement Tools — Special Effect.......ccovinnnn, 15
153 00T SETEES U U TR ORIV PP PRPRPPPPRIS TP PRI RE 15

BIUE MOTE oo eeeeeeeeeeeeee e et eeeeireeeaetarema st a e s s s e 15

SRAIPEI ...ttt 15

SRArPen MOTE ..vveieeciiiie e 15
Preference Page ... icoeoienncetniiisinnnnsnsssesnnnssanss s sacseees 16
Prescan Setting.........c.c...... et ra et e st ar et 16
Auto Scanning SN ..ccocovoioiiinirr e 17
Destination Default SEtNg ..o 18
MOnNitor Calibration .....iveeeeoeeeeee e et as s 18
ELTOIMESSAZE . .vvevvvceesimirieses s ces sttt s 20
TroubleSROOTING ...cueieiiiiene e e 22



There are four property pages available in the TWAIN source window:

Ruler Switch
Click here to
switch among
ruler units.

Ruler

Three measure
units are
available: Inch,
Cm and Pixel.

Scan Rectangle
Lets you define
the image area
that will be
comprised in the
final scan.

e Main page

e Advance page

e Preference page
e About page

This page lets your scanner work in the basic mode. All the control
settings available here are fundamental to the scanning process.
These settings include scanning destination, scan mode, filter,
resolution, brightness, and contrast. The Main page window is
shown as follows.

Property pages
You can select any property page
by clickin% the page tag.

Preview Window |

Lets you preview the prescan Control Buttons
image. The maximum size ot

the preview window is A4.

Scanner
— Control
Settings




Scan Mode

Scan mode lets you decide how the scanner will interpret your image.
Three choices are available in the TWAIN source: Color mode, Gray
mode, and Black/White mode.

Gray mode
Select Gray mode for images that
contain 256 shades of gray.

Line Art mode
Select Line Art for texts and 1ilustrations that
contain only black/white without gray shading.

Color mode
Select this for 24-bit color images.

Filter

Filters are provided to produce dropout effects, i.e., to drop the part of the
image that is in a color difference from the specified filter. Four options
are available: True gray, Red, Green, and Blue filter.

Green Filter

|
True Gray ———p=———y—t—r—
Filter —i! !“j -“J!i- Blue Filter

Red Filter

Please note that the filter option will be unavailable if you select the
“Color mode " in Scan Mode. The disable filter is shown as follows.




Control Buttons in Main Page

Scan Button
Click the Scan button to perform the final scan and
send the result to the destination determined by you.

Prescan Button Exit Button
Click the Prescan button to perform a | Help Button Close this TWAIN
prompt low-resolution scan. The prescan Click this button t0  goyurce window.
image will be displayed in the Preview get on-line help.
window. '

Reset Button

Click this button to return
to the default setting.



Z.oom

The Zoom command allows you to enlarge the view of an image in the
Preview window. However, the zoom function can only enlarge the
image view with one defined scale.

To zoom in:
Click the Zoom command. It will magnify the view in the Preview
window.

To disable zoom in:
After magnifying the view, click the Zoom command again to reduce the
view to its original size.

NOTE:
When zooming in, a vertical scroll bar and/or a horizontal bar will
appear to let you scroll through the entire image.

Mirror

Mirror command lets you change the horizontal orientation of a prescan
image to one that mirrors the current orientation of the image view across
a vertical imaginary line.

To mirror an image:
Click the Mirror command in the Image box.

Invert

The Invert function enables you to make a positive view of a scanned
image negative or to make a negative image positive. By applying this
command, the brightness value of each pixel will change to an inverse
value on 256-color scale.

To invert an image:
Click the Invert command from the Image box after applying the Prescan
function.



In the “Channel” checking box:

All To correct all color components (red, green, and blue) of the
image with the same gamma value.

Red To correct red component of the image.

Green To correct green component of the image.

Blue To correct blue component of the image.

[f channel “All” is chosen, the gamma value is applied to all the
red/green/blue channel. Otherwise, gamma value for red/green/blue 18
applied to red/green/blue component respectively.

HSV

Choose the HSV command from the Tools menu. The Hue & Saturation
dialog box will display and allow you to adjust the hue and saturation of
its pixels in an image while keeping the brightness level unchanged.

Hue is the wavelength of light reflected directly from an image and it is
represented by the name of colors. Adjusting the hue changes the whole
color appearance of the image. Saturation is the strength of the color,
referring to how far the color is from a gray of equal intensity. Adjusting
the saturation changes the degree of the purity in proportion to the hue.

A Hue & Saturation O E|
Hue: _4_1 __i ¢ {188188;
P R I oo

%] o j

o To adjust Hue and Saturation:

1. Hue adjustment
In the “Hue” box, specify an angle value (you can either directly enter
the desired value in the edit box or use the scroll bar to select your
desired value). The specified angle value represents a move around the
color wheel. (Remember that hues are specified as angles on the color
wheel. If you are not familiar with the notation of color wheel, please
refer to any relevant book about color.)

12



Auto Color Control

The Auto Color Control automatically adjusts the colors of the scanned
document spread over a 256-color scale. Before performing this function,
please click on the Preview icon first.

Color Correction

Click on Color Correction icon, and a dialog box will appear. Choose
Disable item for scanning without color corrected. Choose Enable Color
Correction item for color correction to acquire high fidelity images.



Preference Page

The preference page mainly lets you do three different settings:
Prescan setting, Auto scanning setting, and Destination default
setting. The preference page is shown as follows.

Auto scanning setting

Main | Advanced Preferences | About |

- Prescen selting ~1 Ao scanning sl
[V Area detection % ¢ Enable‘suto Monitor
Prescan o . .
. B ™ Prescan T Calibration
setting W amsdstection ST
I¥ Scan and-sand to destinalion: - |
. SR 4 \ Lamp
~ Destinalion default setting Calibration
File:-
Destination Ptirker: Fﬁasedel 3
dcf:a!ult EMad
setting — T .
Attach file name: r
¥ Delete altach file after transmission
FAX:

Prescan Setting

Prescan setting
V¥ Area detection

Check
Box

- By checking the “Area detecting” option in the Prescan
_ setting area, you enable the auto area detection function.
~ Next time you perform the prescan function, the whole

' area of your scanned image wiil be automatically

- highlighted by the scan rectangle in the preview window.



Destination Default Setting

Destination default setting area lets you define the Jocation to save
or send your scanned result. You can set up File, Printer, E-Mail,
and Fax in this area.

By clicking here, the “Save As” dialog box will
display. You can decide the Jocation and folder
to save your scanned image file.

— Destination default setting _— e

File: r v

i Appoint the
Printer: - o

! FP Laserlet 4 o | printer here. This
E-Mail . - printer will

perform the
printing job as
¥ Delete attach file after transmission you apply the

* Send to Printer

r ' 11 in Destination
- o]} setting.

Type in the fax number o whom you
want to send the scanned result.

Altach file name: [ . ' ;

Fax:

Monitor Calibration

The Monitor Calibration allows you to adjust the
gamma value and gain parameters of your monitor to
increase the visual perception. After clicking this icon, a
new dialog box entitled “Monitor Color Matching”
appears as follows.

The preview scanned image has uneven vertical lines
or incorrect color registration. Use this function to
rectify the value and acquire better screen display.




Error Message

It will pop-up some messages as you launch the scanner driver. We will

explain the errors on the following list.

[ Error Message |

Solution

Insufficient memory to operate. ®

Adjust the width of the scan
area or the resolution.

i

| ® Close all the other applications.
[Can't load dynamic library. '® Close all the other applications
Failed to load the scanner driver. | which probably using the

! driver.

| ® Reinstall the driver from drier

disk or Scanner CD.

}Mail system has not been setup in |®
‘your computer.
"Failed to load your E-mail function
trom the mail library.

‘Failed 10 log on MAPL

‘Failed to send the docunents via
'MAPI.

Failed to log off MAPL.

Failed to log on E-mail system.
[Failed to send documents via E-

Imail system.

Check whether the Microsoft
Mail is setup in your computer
correctly.

\
Can't log off. |

’Errors occurred while calibrating. @ Check whether the scanner j
| | connects to the computer.
\ }. Make sure that the scanner
| connects to power, and the
F \ LED is on.
No default printer. '® Install a printer driver and
| connect the printer to the
| computer.
(Can't print. ® Make sure that the printer and
“Failed to activate the printer. its driver are setup properly.
Failed to prepare the printing job.
Make sure that the fax machine

‘Failed to activate the fax.

|
» |

\ o

and its driver are setup
properly.

[Failed to send the scanned image to)®
the Clipboard! ®

Not enough system memory.
Close the other applications.

[The image is too large to export to .

Reducing the image size by
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Troubleshooting

If your scanner fails to operate normally,

first look through the symptoms

listed below and find the one that is closest to the symptom of your
scanner. Then follow the recommended remedies Jisted for that symptom.

A

Symptom

Remedy ]

01 |Scanner does not react.

Please follow these steps:

1. Make sure the power adapter 1S properly
connected. (The LED in the front panel
should be on.)

7 Make sure the scanner cable is properly
connected.

3. Remove any other EPP device
(IOMEGA or Mini SICI device.)

4. Check the BIOS to sec if the parallel port
is set to “EPP mode.” (Please refer to the
manuals of your pc and its mainboard.)

5. Reselect the scanner source in the
application.

6. Reinstall the scanner driver.

7. Reboot your computer.

Scanning speed is 100
slow.

¥ Lower the resolution (reduce the DPI)

8. Check the BIOS to see if the parallel port
i« set to “EPP mode.” (Please refer to the
manuals of your pc and its mainboard.)

» Remove EPP device or remove Keypro.

(03

Printer does not
function.

 Make sure the scanner cable and the
printer cable are propetly connected.

» Make sure the LED is on.

04

Scanner does not react
when the AutoScan

button on the front panel
is pressed.

¥ Activate the scanner driver (open the

scanner user interface) first, then press
the AutoScan button.

Make sure the “AutoScan” function 18
activated.

05

The TextBridge Classic
software does not

support Word 97.

Please run the “Tb96updt.exe” in the
TBRIDGE folder on your scanner CD.
You should then be able to OCR the text
into Word 97. You can also download the

updated version from this Xerox URL:

inlsl



http://www.xerox.com/xis/tbpro%win/tb
pro9 6wint'1bsgroupd.htm#tib245 .
The image on the screen ¥ Monitors of different brands have
is too dark or too bright.| different Gamma values which affect the
brightness of the image displayed in the
Preview Window. Please openl the
TWAIN source, and click the Monitor
Calibration icon on the Preferences page
to adjust the Gamma value of the image.
You should use the same procedure if this
problem occurs in image processing
software.
» Remove the display screen filter if you
have one.
» Adjust the light source on your desk.
» Adjusting the monitor's Gamma value
only changes the brightness of the
monitor, not that of the scanned image
itself. Please open the TWAIN source and
adjust the brightness on the Main page.
You can also click the Gamma icon in the
Advance page to adjust the Gamma
value.
» Remove the display screen filter if you
have one.
b Adjust the light source 0 Y0

07 The scanned image s
100 dark or too bright.

ur desk.




adjusting the width or
resolution of the scan area.

® Reduce the width of the scan
area or the resolution.

® Increase disk space.

the Clipboard!
Image size exceeds 15.9375MB.
Cannot save the file. Insufficient
disk space.




& Monitor Color Matching

To perform monitor calibration to your computer:

5 In the “Gamma Adjustment” box, adjust for a suitable value for each
of the primary color channels used by the monitor.

....until by your
visual judgment the
- Vary the colors of these two
- value here... areas come to one

Channels together, check the “All”

To vary the gamrﬁguvalues of the three channels to

box.
2 In the “Gain Adjustment” box, adjust for a suitable gain value for each

of the primary color channels.

Vary the value here.....

L TRRPRNY, e

_..until by your visual judgment the rightmost edges of this color
strip appears black which fades in graduation to the left.

To vary the gain values of the three channels together, check the “All”

box.
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Auto Scanning Setting

Auto scan is a fully automatic function, which enables you to
complete a scanning process with your finger tip. By checking the
“Enable auto scanning” option in the Auto scanning setting area,
the auto scanning function is empowered. Please note that the
default seitings for Auto scanning setting are shown as follows.

Default __| r. Prescan |
Setting 1 hyesdetsction.

e
~7[T~” Enable auto scanning .

| Sean and sendto destination

The steps for auto scanning are:

1.

Locate the auto scan button which is situated in the front panel
of the scanner.
Push the button. The scanner will start the scanning process.

. If you check the «prescan” box, it first makes a preview

scanning and displays the scanned image in the preview
windows. (If the «“prescan” box is not checked, you can omit
steps 3 & 4.)

The scanner performs the auto area detect function (please first
check the “Area detection” option) to define the actual area of
your scanned image in the preview window. Later, this defined
area will be used for final scan.

The final scan starts to run and the scanned result will be sent to
the destination (e.g., File, Application, Mail, Clipboard, Fax or
Disk), which depends on your choice. For the purpose of
performing this step, please ensure that the “Scan and send to
destination” option is checked. (If the “Scan and send to
destination” is not checked, the scanning process will stop at
step 4.)



Image Enhancement Tools — Special Effect

Special effect tool enables you to create special and spectacular
effects in your scanned image. As you move the pointer to the left,
you will get the Blur effect. Reversely, as you move the pointer to
the right, you will get the Sharpen effect.

Default location for the pointer

Blur
Blur is used to slightly soften all or part of an image. It smoothes an
image by decreasing the contrast between adjacent pixels.

Blur More

Blur more softens the image moderately.

Sharpen

Sharpen gives emphasis to the color differences between adjacent pixels
of different colors. It is used to electronically strengthen the focus of
blurry images by means of increasing the contrast of adjacent pixels.

Sharpen More
The use of Sharpen more is to moderately sharpen the image.

15



2. Saturation adjustment
In the “Saturation” box, specify a desired percentage value of the
saturation. A value of —100 converts the image completely to a
grayscale image and a value of +100 shows the image with fully
saturated hues.

Tone Adjustment

For the purpose of correcting image distortions that take place during
scanning, you use the Tone adjustment to make the compensation on
scanned images. Tone adjustment allows you control the conjunction
between the shadows, midtones, and highlights of your image. Use it to
restore detail that is lost in shadows or highlights, to correct over or
under-exposure, and to improve the tonal quality of your image.

From the Tools menu, choose “Tone”. A dialog box entitled “Tone
Adjustment” appears.

You can adjust the tone value by using the mouse cursor to reshape the
tone. Curve-based editing enables you to find outa problem area and
make subtle or notable change in that image area. The available range for
Tone Adjustment is from 0 to 255, and the default value is x=130 and

y=130.
The Tone Curve takes an original pixel brightness value X as inputand Y

as a new output brightness value. The resulting curve is a visual
representation of the balance between shadows, midtones, and highlights.



Descreen

Click the descreen icon, a dialog box
titled "Descreen” appears. There are
three items in the top dialog box:
Normal Scan, Default Setting and
Customize. Select "Normal” then
descreen will not perform onto the
scanned images. Select "Default” to
perform the default setting of various
document types. In addition, select
"Customize" to define your own
descreen level by entering a desired
value in the number box.

Descreen filter is used to eliminate the moire patterns (wavelike lines) in
images. As images are scanned directly from screen-print media (like
newspapers or magazines), you should notice that scanned images usually
come with wavelike patterns and banding lines. As long as the scanning
resolution is not set very high, you can apply this function to remove those
annoying effects. (When this function is activated, the scanning speed will
become slow.)

Gamma

Sometimes you wish to adjust the brightness of midtones of the scanned image
while keeping shadow and highlight areas relatively unchanged. The Gamma
correction function allows you to increase or decrease the intensity of the
middle gray tones.
|3 Gamma conection _______E3|
R S S The available gamma value
' ‘I ranges from 0.01 to 7.99. The
default value is 1.0. Changing
the gamma value above 1.0 will
brighten the midtones, and
below 1.0 will darken the
midtones. You can either enter
the desired gamma value in the
edit box or use the scroll bar to
select your desired value.

(Qa:ﬁcélhﬂ' = Default -

I



Advance Page

Preview

While including the basic functions of the Main page, the Advance
page also encompasses image enhancement tools that can be used
to compensate for any color distortion of the scanned image. The
Advance page is illustrated as follows.

Window

Size
Press the right

mouse button in

the preview
window a
rectangle box
with a list of

sizes will pop-up.
Please select one -
then press "Scan”.
directly.

Image

~Special effect
i [ERT

k4] ¢

— Enhancement
Tool

- Setting

Decztination

" Fiter
2 : . f ! Resclution
' . © i Brightness
t
wigth: {35 = Hegne[177 -

¢ Contrast

fal

: Scan Made

L]

sp 00 T 19200 |
100 B =] 100
e B 100 |

Jihage memaory size: 25.61 MB

Scan Control
| Tools (same as
Main page)

Image Enhancement Tools — Image Box

Mirror Descreen HSV

[

Auto Color

Control

2\

/

e

.

?

Zoom Invert Gamma

Tone Adjustment

Color
Correction



Resolution

The resolution is measured in dots per inch (dp1), which is used to represent the
image detail in a given area. The available resolution ranges from 50 to 19200.
Generally, the higher the resolution means the sharper and higher the quality of
the scanned image. However, in some cases, high resolution is not necessary
because resolution is determined or limited by many factors: image type, the
original image's resolution, the output device's resolution, the available
memory space in your hard disks, etc.

. Pointer Edit box

You can adjust the resolution by dragging the pointer to the desired resolution
- or directly key the value into the Edit box.

Brightness

Brightness refers to the intensity of light reflected from or transmitted through
an image. The larger the brightness value, the brighter the image appears. You
can either drag the pointer or key the value into the Edit box to change the
value.

Contrast

Contrast refers to the differences in the brightness between the light areas and
the dark areas of an image. The larger the contrast value, the higher the
differentiation between the light and the dark areas.

You can either drag the pointer or key the value into the Edit box to change the
value.




Settings in Main Page
Destination

Destination is the location where you want your final scanned
image to be sent. There are six options available: Application, Disk,
Printer, Mail, Fax, and Clipboard.

Send to Printer

Send to Application
Click this button to send
the scanned image to your
application program-

This selection lets you
send your scanned image
directly to the printer fora
printout.

Send to Fax
This lets you send your
scanned image to other

/ people through fax.
et Please go to the

preference page to set
up the fax number.

0

J
- i

Send to Disk
Lets you save your
scanned image to a disk.

Send to clipboard

Click this button to save the
scanned image in the clipboard
and wait for your further
application.

Send to Mail

This function lets you send
the scanned image 10 others
through e-mail. Please g0 to
the Preference page to SetUp
the e-mail address.

NOTE

Make sure that the M3 Exchange, MS FAX, Modem and its driver are setup
properly. Please refer to Microsoft’s web site (http:/fwwwmicrosoft.com) for
<nstructions about setting MS Exchange and MS FAX.



Getting Started with TWAIN Source

Opening the TWAIN Source Window

There are two ways to open the scanner TWAIN source window.
>> To request the TWAIN source from application programs:

1. Choose the "Select Source” command from the File menu of the
your application. The Select Source dialog box will be
displayed. If you only have installed this TWAIN Source, you
can skip this step and step 2 The host application will
automatically select it as the default TWAIN source.

7. Select the ARTEC 1236P/636P TWAIN source from the

- "Sources" list box.
3. Click the "Acquire” command to activate the TWAIN Source.

>> To activate the TWAIN source directly from Windows (stand-
alone mode):

1. Click the Windows «Srary” button to open the Start menu.
2. Choose Programs ~ SCANNER 32 > SCAN32 from the menu
to run TWAIN source.

NOTE:

Not all application software put their "Select Source” and "dcquire”
commands under the File meni. If you couldn't locate these two
commands, please check other menus for them. For best results, make
sure the Document Cover is closed before performing scan.

(V9]



FEDERAL COMMUNICATIONS COMMISSION

NOTE
This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits aré designed to
provide reasonable protection. This equipment generates, Uses and can radiated radio
frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. However, there is nNo
guarantee that interference will not occur in @ particular installation If this equipment
does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures.

_Reorient o relocate the receiving antenna.

-Increase the separation between the equipment and receiver.

_Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

_Consult the dealer or an experienced radio/TV technician for help.

Shielded interface cables must be used in order to comply with emission limits.

Changes of modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate the equipment.

1



